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1 Connector Description

Figure 1: Front

Figure 2: Back

Connector Description
HF FM antenna RF output to receiver (75 Ohm coaxial, maximum length: 3m)
ETH Network connection to PC or ethernet switch (CAT 6a STP or better, maximum length: 3m)
RS232 Connect to PC via supplied USB adapter (for setup and service only)
Power On / Off power switch
9-18 V= Power supply (back side): The Modulator must be used with the supplied mains adapter.
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2 Package Contents

Following parts are contained in the box:

(1) MultiFM Modulator Hardware
(2) 12-Volt power supply
(3) RJ45 network cable
(4) USB/RS232 service cable
(5) License sheet
(6) newest MultiFM Software from:

http://www.maintech.de/multifm

3 Starting up

For the initial start-up of the modulator please proceed as follows once:

1. Install the latest MultiFM software on a Windows-PC (https://www.maintech.de/multifm)

2. Connect the PC and the modulator (1) using the network cable (3)

3. Start the MultiFM software on the PC and turn the modulator on (red light)

4. Setup IP-address of the modulator via service cable (⇒ 4.1), then connect (Ctrl+O)

5. Enter existing license key (Ctrl+K)

6. (optional) Load an example project via Menu ⇒ Help ⇒ Load example (see ⇒ 12)

This software documentation (PDF) can be opened anytime via Menu ⇒ Help ⇒ Documentation (or with Ctrl+H).
The start-up steps has to be done only once. If the software is restarted later and the modulator is turned on, the
connection is reestablished automatically with the last used project.

4 Hardware Settings

4.1 Configure Modulators IP-Address

Modulator and MultiFM software communicate via Ethernet (UDP). Therefore, both devices must be assigned with
IP-addresses of the same segment. Use ipconfig on the command prompt to find out the current IP-address of the
PC. The modulator has to be assigned an IP-address within the same network range.

1. Start the MultiFM software

2. Connect the service cable (4) to the PC (USB) and the modulator (RS232)

3. Open the config dialog via Menu ⇒ Modulator ⇒ Config...

4. Choose COM port; on success the PLL fields should become editable

5. Fill in the desired host IP and port number for the modulator

6. Confirm by clicking [Save] and [Close]
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Figure 3: Configuring IP-address and Connecting two Modulators

4.2 Connect the Modulator via Network

1. Start the MultiFM software

2. Choose menu ⇒ Modulator ⇒ Connect... (or press Ctrl+O)

3. Choose 2 as number of modulators to connect to (⇒Figure 3)

4. Double click on [#114] and [#100] to choose discovered (green) modulators (⇒ blue)

5. (optional) Press [+] and enter IP-Address and Port number manually

6. Confirm the selection by clicking [Connect] and [Close]

MultiFM since v4.xx can connect up to four modulators. Therefore up to 96 FM channels (24 per modulator) can
be transmitted/modulated simultaneously.

4.3 Calibrate PLLs (Frequency offset)

The RF design of the modulator is based on two PLLs that are in charge of the lower and upper half of the output
spectrum. To avoid a gap in the middle of the spectrum, these two PLLs have to be aligned to each other. This
alignment is also necessary to remove the absolute offset of the output frequencies. All modulators are properly
aligned during manufacturing and initial testing by maintech, but the process can be repeated by the customer if
necessary:

1. Start the MultiFM Software (after initial start-up is done ⇒ 3)

2. Connect service cable (4) to the PC (USB) and the modulator (RS232)

3. Select the EU frequency band and setup two channels, at 93 and at 103 MHz, with the following parameters:

• select no audio and no RDS source (default)

• set channel mode to Mono (click on the Stereo symbol)

• set attenuation to 0 dB (default)

4. Choose Menu ⇒ Modulator ⇒ Config...

5. Choose COM port (PLLs should become editable)

6. Verify the deviation from 93 MHz with a spectrum analyser (Center 93 MHz, Span 4 kHz)

7. Modify PLL-Offset1 (for all frequencies lower than 98 MHz).

8. Confirm by [Save] or press the return key. Repeat from step 6 if necessary.

9. Verify the deviation from 103 MHz with a spectrum analyser (Center 103 MHz, Span 4 kHz)

10. Modify PLL-Offset2 (for all frequencies from 98 MHz and above).

11. Confirm by clicking [Save] or press the return key. Repeat from step 9 if necessary.
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5 MultiFM Software Overview

The MultiFM software is structured in four main categories/pages: Channels overview, Audio sources, RDS sources
and TMC sources. The Channels page acts as a distributing matrix for all channel settings for the sources (Audio,
RDS/TMC) and for the RF configuration parameters. The pages can be switched by clicking on the category tabs
in the upper part of the window (⇒Figure 4).

Right next to the tabs a schematic representation of the output signal spectrum is shown (green lines) with the
expected intermodulation products (red parts) and a flag for the currently chosen VHF frequency range/band (Europe,
Japan, Brasil). On the right, the [OnAir] button enables or disables the output of the RF signal.

At the bottom right of the window the current connection status is displayed: The modulator number(s) and remote
control IP-address. A green bulb indicates a successful connection.

Each channel has his own configuration panel. A detailed description of the options can be found in chapter ⇒ 7.

Figure 4: MultiFM Channels overview

If the frequencies of two channels are to close to each other, this overlapping will be marked yellow if the distance is
≤ 300 kHz or red if ≤ 200 kHz.
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6 Project Settings

The MultiFM software manages all settings in a *.fm project that can be saved and reloaded. Thus it is possible to
switch between complete sets of parameters and to prepare different test scenarios and process them systematically.

6.1 Create, Save and Load Projects

• Choose project ⇒ New (or Ctrl+N) to set up a new empty FM project

• Save a project with Project ⇒ Save (Ctrl+S) under a new name

• Open an existing project with Project ⇒ Load (Ctrl+L)

• The last n projects (for n ∈ {1, . . . , 9}) can be reopened with Ctrl+Shift+n

6.2 Frequency Band (Europe, Japan, Brasil)

The chosen frequency band can be changed by a click on the flag in the top right or by pressing Ctrl+B:

• Europe: 87,50 to 108,00 MHz

• Japan: 76,00 to 90,00 MHz

• Brasil: 76,00 to 108,00 MHz

A global RF attenuator may be set here from 0=full output power (default) up to -31 dB. This is recommended e.g.
if a direct cable connection is used between the MultiFM modulator and the radio to counteract an overdrive in the
receiver. Also inserting a hardware attenuator unit may be meaningful in such a setup.

6.3 Stop and Resume Modulation

Clicking the button disables all RF output. Clicking again reenables the modulation of all channels.
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7 Configuring Channels

Up to 24 single RF carriers per modulator can be configured in the channels overview. Pressing keys 1..0 toggles
the modulation of channels 1..10 on or off. Pressing Ctrl+1..0 turns channels 11..20 on or off. Figure ⇒ 5 shows an
example channel status.

The following information are displayed:

• Channel [4] is active (transmitting) in stereo mode

• Transmitting frequency is [96,00 MHz]

• Attenuation is set to [-5 dB] (for global attenuation of all channels see ⇒ 6.2)

• Audio volume is set to [50%]

• Audio source used is [Audio-1]

• RDS/TMC source used is [RDS-1]

Figure 5: Channel status

7.1 Frequency, Attenuation, Volume

Clicking on the frequency opens the slider which sets the transmitting frequency of the channel.

Figure 6: Frequency setting

The frequency is set by dragging the red circle or by the keys +, -, Home, End, PageUp, PageDown or by the arrow
keys. With the left/right arrow keys the frequency can be changed in kHz steps. To reach the intended frequencies
as close as possible, it may be neccessary to calibrate the PLL units (⇒ 4.3). It is also possible to enter 958 to set
the frequency to 95.8 MHz directly.

The setting of attenuation and volume works accordingly.

7.2 Choosing Audio and RDS Sources

Different channels are able to send the same RDS or audio data on different frequencies. Therefore, the soft-
ware distinguishes different RDS and audio sources that can be selected for each channel in the channels overview
(⇒Figure 4). The mechanism acts like a switching matrix which is able to route different input signals to the outputs.
For an example see ⇒ 12.3.

Clicking on the RDS or audio source of a channel opens a drop down list of all available sources. A right mouse click
on the source opens a context menu that allows a quick jump to the configuration page of the current source.

If <no RDS> is selected, no RDS carrier is modulated on that channel. Otherwise the RDS carrier is generated on
the current frequency with the data of the given RDS source.
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7.3 Status Icons, Muting, Channel Editor

Right next to the sliders and source selection, the channel status is displayed with small icons.

Clicking the loudspeaker symbol mutes the audio. The RDS and (silent) PCM datastreams are still transmitted and
the channel RF stays active.

Clicking the gearwheel symbol opens the channel editor (⇒Figure 7). The channel editor allows the setting of
preemphasis, frequency deviation, sample rate and mono/stereo mode. The frequency deviation can be set to the
standard values 50/75 kHz or as an arbitrarily value between 0..130 kHz. The attenuation can be set here, in addition
to the slider (⇒ 7.1). If [kHz Auto] is selected, the sample rate is automatically adjusted to the sample rate of the
new song on each song change.

The channel editor allows to copy the settings to all other channels or a selected range of channels.

Figure 7: Status icons and channel editor

The green dots that are displayed in a 3x3 grid for each channel correspond to the settings in the channel editor.
These dots and the stereo symbol can be clicked directly, switching the related setting. This way, settings can be
changed faster than by opening the channel editor. When the mouse rests a moment on an option, the current value
is displayed in a tooltip.

A yellow flashing dot indicates that the current used sample rate does not match that of the current song. This
means that the song is played too fast or too slow. By clicking on the yellow dot the correct sample rate can be set
directly.

Additionally, three bar graphs are displayed representing the following values:

• on the left, the audio PCM fifo fill level is displayed (from red=empty to green=full)

• in the middle, the RDS/TMC fifo fill level is displayed (colors similar to audio)

• on the right, the multiplex power is displayd in dB (from blue to white)

The level bars will be outlined in yellow if the measured transmission rate does not match the expected transmission
rate. This is the case at the first start (the measured send rate is not yet accurate enough) or if packet losses occur.
If a fill level bar remains permanently outlined in yellow, the network setup should be checked.

The multiplex power depends on the audio volume. Ideally, the volume should be chosen so that the value is around
0 dB. If a red dot is displayed here, the audio signal may be clipped. In this case, the volume should be reduced.
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8 Audio Sources

Each channel with assigned audio source generated a PCM data stream. Following signal generators are available:

• Constant sinus, seperately configurable for the left and right stereo channel

• Sinus sweep (ramp) with configurable time course

• A single song (ogg vorbis, flac, wav or mp3*)

• A playlist consisting of several songs

* All audio files have to have a 16-bit, two channels 32, 44.1 or 48kHz sample rate. Some mp3 files may have
unknown meta information (tags) so that they cannot be identified and played out correctly. If possible, these mp3
files should be converted into xiph formats OGG or FLAC, e.g. by foobar2000.org. Using this tool the tags can also
be (re)set , e.g. for RadioText+.

Figure ⇒ 8 shows an example configuration of four audio sources.

Figure 8: Audio sources

A correctly played out audio file is highlighted in green, a faulty or not decodable song in red. When keeping the
mouse pointer still upon the file name or upon the audio source in the channels overview, the available tag information
(artist, album ...) is shown in a tooltip.

In column [Audio sources], new sources can be set up or existing ones can be changed or deleted. Source attributes
are name, operation mode (sinus, ramp or file) and the related parameters. Songs can be dragged into playlist (copy)
and playlist or songs can be dragged into a file source.
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8.1 Constant Sinus

The frequency and volume can be set separately for the left and right channel. If mono is selected, both frequencies
are transmitted on both channels (L/R mixed).

8.2 Sinus Sweep (Ramp)

Set the start and end frequency, the volume and the time duration between start and end. The ramp is repeated
continually on both L/R channels.

8.3 Songs and Playlists

A playlist contains a list of audio files (songs) that are played back successively. After the last song is played it starts
over again with the first song.

With the following steps a new playlist is created and assigned to an audio source:

1. Create a new playlist in column [Playlists] by clicking the [+ List] button.

2. Change the name of the playlist if necessary (doubleclick the name or use the F2 key).

3. Add several files to the playlist in the right [Files] column with the [+ File] button.

4. To assign a playlist to an audio source, change the source type to [File]. Then, drag&drop the playlist on the
parameter field of the source: Press the left mouse button on the name of the playlist, hold and drag it onto
the audio source until the [+] symbol appears, then release the mouse button to drop it there.

5. If only a single song should be played in a loop, drag that song directly onto the audio source.

6. Selected files can also be copied with drag&drop into other playlists.

7. Finally, ensure that the newly created audio source is assigned to a channel: The audio source must be chosen
for at least one channel in the channels overview (⇒ 7.2).

– 9 –



9 RDS Sources

Each channel with assigned RDS source generates a bit stream according to the standard IEC / DIN EN 62106 or
ISO 14819. Understanding the configurable parameters requires an understanding of the standard and a detailed
explanation of the values and of their function would go beyond the scope of the manual. Therefore, it is assumed
that the user of the MultiFM Modulator is well acquainted with the RDS standard.

Figure 9: RDS sources page

A RDS source configuration consists of several parts, grouped into following sub-tabs:

• Basic settings (⇒ 9.1) like PI, PTY, PS, Long PS, Error-Generator etc.

• Alternative Frequencies (⇒ 9.2)

• RadioText & Enhanced RadioText (⇒ 9.3)

• RDS2 & ODA Streams (open data, work in progress)

• Log Files (⇒ 9.4)

• Packet statistics (⇒ 9.5)
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Each RDS source creates a defined bitstream that can be sent on several channels / frequencies independently. The
channels tab shows which RDS bitstream is sent on which channel (⇒Figure 4) and allows to set it (see ⇒ 7.2). If
<no RDS> source is chosen, no RDS carrier is sent on the channel. In all other cases, a RDS carrier is generated,
as well in mono as in stereo mode.

The packet statistics allows analysis of the transmitted bitstream (blocks or groups depending on nomenclature). It
also helps verify that the the information really arrives at the RF signal at the necessary rate. Apart from that, the
created datastream can be saved into a file to analyse it with an alternative software or to replay it without the need
to rebuild the configuration etc.

9.1 Basic Settings / Transmission Rates

The basic settings (⇒Fig. 9) include the most commonly used flags, RDS groups and an error generator that generates
intentional bit errors in the created RDS data stream, e.g. for fuzzy testing the receiver/radio.

If no RDS groups are selected, the bitstream will consist only of 0 bits (empty). It will not be decodable. However,
the 57 kHz RDS-subcarrier is sent as long as the channel is set to send/active.

By placing a check mark in front of any group (⇒Fig. 9) or, in the case of RadioText, by checking [send] (⇒Fig. 11),
a decodable RDS bitstream will be generated with all selected groups. The packet statistics (⇒ 9.5) is very useful
to verify which data/groups are currently transmitted by the modulator.

Each groups transmission rate is specified in groups per minute. A stream can send a total of max. 685 G/min.

9.1.1 Basic Tuning Flags, PI Code and PTY

Here the basic and most frequently sent flags of the RDS bitstream are set.

The PI code (Progam Identification), the number of the group and the flags Program Type (PTY) and Traffic
Program (TP) are transmitted in all groups. Traffic Announcement (TA) and the Decoder Information (DI) are
transmitted only in the groups 0A, 0B and 15B.

The PTY (program type) defines the kind of content as a value between 0 and 31. PTY and TP are always
transmitted in the second block of each RDS group. A table with the meanings of the different values for the PTY
can be found in the RDS standard. The PI code (program identification) is sent in the first block (two bytes) of each
RDS group.

The DI contain the PTYI (PTY indicator) for dynamic PTY. If set, the PTY may change at any time with the type
of program being broadcast.

(!) In the 2018 standard, the flags Artificial head, Compressed, Stereo and Music/Speech as well as the parameters
Pager and PIN have been removed. However, these can still be activated/set in the software.

Changing a flag or other parameters immediately affects all channels transmitting this RDS source. Setting e.g. the
TA flag makes a compliant FM radio switch to the ”Traffic Announcement” mode.

When switching the TA bit, a burst of 14B (EON) as well as 15B groups can be sent to notify a capable receiver.
The number of the groups and their duration can be set for TA=1 (on) and TA=0 (off). If the number is set to 0,
no burst will be sent. If the duration is 0 or too low to transmit the number of burst groups in the given time, no
other groups will be sent between the burst groups.
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9.1.2 Group 0x: PS name, AF, TA

Here the program service name (PS) and, if configured, the alternative frequencies (AF) are transmitted in 0A, else
0B groups. Also the flags Music/Speech (obsolet) and TA are transmitted. The encoding for PS is defined in table
E.1 of annex E in the standard. Characters can be created directly from a hex value xx with [#xx]. F.i. [Hello#21]
creates [Hello!] where 21 is the hex value for the exclamation mark.

All in all, four 0-groups are necessary to transmit the PS name (8 characters) completely. At least two 0-groups per
second should be sent which means that the sending rate should be set to at least 120 G/min.

According to the standard, scrolling PS is not allowed. For longer station names or messages Long PS (since standard
2018) or RadioText should be used. Nevertheless, the RDS generator features this function for testing purposes. To
create a scrolling PS, the PS has to be longer than 8 characters. Additionally set how often a PS segment is repeated
and by how many characters the text has to advance afterwards. When the PS is sent completely, it starts from the
beginning again.

9.1.3 Group 15A: Long PS name

Analog to PS also the Long PS name with up to 32 bytes may by transmitted. The Standard encoding is UTF-8
but may be switched to f.i. GB18030, which is widespread in the Asian region. By selecting BOM (Byte Order Mark,
Unicode U+FEFF) an identifier is preceded, by which the decoder may detect the used encoding. With [#xxxx] any
unicode character may be inserted from the value xxxx, f.i. [#03C0] inserts the small pi letter [π].

9.1.4 Group 1A: ECC and PIN

With group 1A the extended country code (ECC) can be transmitted. A clicking on the [C/ECC] button opens a
dialog for selecting a country code. Search for countries or filter by global areas to narrow down the list. A double
click on a country changes both the ECC and the CC (Country Code) in the first character of the PI code. The
settings for Germany are: ECC = 0xE0 and CC = D or 1.

The program item number (PIN) contains the scheduled transmission start (5-bit day of the month 1-31, 5-bit hour
0-23 and 6-bit minute 0-59) of the currently sent program segment. Month = 0 (e.g. PIN = 0) signals that the PIN
is not set.

(!) PIN and Pager have been removed in the 2018 standard. However, these can still be set in the software.

9.1.5 Group 4A: Date and UTC Time

With this group, the current date and time can be sent to receivers/units, which may not have another time sources
(as f.i. GPS / Internet). Time is sent once every full minute so that the receiver gets the message at second 0.
Reference time is the current time of the computer running the software. When noticing discrepancies, check the
Windows system time.

9.1.6 Group 8A: TMC (Traffic Message Channel)

In group 8A TMC messages are sent if a TMC source has been chosen. Apart from that, group 3A announces
the presence of TMC by transmitting the applications identification (AID) for TMC (usually CD46). The AID is
configured in the TMC System Informationen (⇒Fig. 13 and ⇒ 10.2).

(!) Some receivers will not recognize TMC if group 3A is not sent or the AID is wrong.

If [free] is checked, the sending rate for TMC groups may increase above the given G/min rate, if the maximum
sending rate for RDS is not used up by all other groups (e.g. free rate is available).

– 12 –



[GAP], on the other hand, limits the transmission rate to the extent that a certain number of other groups must
always be transmitted between two TMC groups. For example, with GAP=3 max. 171 G/min can be transmitted
(per stream).

9.1.7 Group 3A: ODA (Open Data Applications)

ODA groups announce the existence of open data applications that are not defined in the RDS standard. Among
others, these are TMC, enhanced RadioText (eRT) and RadioText Plus (RT+). If no group 3A is sent, it is possible
that the receiver cannot recognise TMC even if TMC data is transmitted in group 8A. Transmitting group 3A should
therefore always be activated when using any ODA (TMC ⇒Fig. 13 or eRT and RT+ ⇒Fig. 11).

9.1.8 Group 14A: EON (Enhanced Other Networks)

TP=0 (off) and TA=1 (on) signals that EON information that refer to at least one other program with traffic
information are transmitted. Thus, RDS receivers can recognize traffic announcements in other programs.

RDS sources with TP=0 and TA=1 have to refer to a program with TP=1 in at least one EON group.

In the EON list, all data have to be entered either manually (channel=0), or the number of another transmitting
channel (program) is entered into the channel field. In that case, the data is taken automatically from the RDS
source of the other channel. If the TA flag of the RDS source in the referenced channel is set to TA=1, a burst will
be generated (14B groups) and the receiver should tune to this channel until TA=0 is recognized again.

The number of burst groups (14B) and their duration can be set separatly for TA=1 and TA=0. If the number is
set to 0, no burst will be sent. If the duration is 0 or too low to transmit the number of burst groups in time, no
other groups will be sent between the burst groups.

A burst can be triggered by toggling the TA flag of the RDS source in the linked channel or, if no channel is given
(=0), directly by the TA entry in the EON table row.

9.1.9 Error Generator

The error generator creates intentional bit errors in the transmitted RDS data stream. This function enables the
simulation of difficult receiving conditions in the lab. According to the configured error rate, bits are either inverted
continually or set to 0 or 1 constantly. If the error rate is set to [per group], the same number of bits are changed in
every RDS group. One RDS group consists of 104 bits, so an error rate of 1% means about one bit per group.

After the bit errors have been inserted, certain parts of the RDS group can be rectified again. These parts are the PI
code, the target group and the checkwords. This way, incorrect data with correct checkwords can be routed to the
group-related receiver parts for testing. This possibility should help finding software errors in decoder parts that get
the data not until after correct checkword checks and therefore cannot receive data errors under normal conditions.

Feeding such random data to these software sub-units can be seen as fuzzing or fuzz testing.
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9.2 Alternative Frequencies (AF)

If activated, AFs are transmitted in 0A groups together with PS.

Figure 10: Alternative frequencies in RDS

9.2.1 Automatic and manual AFs

The channel automatic mode finds the frequencies of all channels using the same RDS source. This means that all
frequencies that belong to a certain station (same PI/PS) are listed under automatic. Each channel transmits the
frequencies of all other channels in its AFs in group 0A.

Additionally, frequencies can also be added manually to include stations with a different PI code, or even if there is
no channel at all transmitting on that frequency (or it is an external station).

9.2.2 Method A/B

The standard defines two methods for the encoding of the AF. Procedure A transmits a list with up to 25 AFs.
Procedure B can be used for bigger lists, or when it is necessary to mark regional stations (similar programs with
different PI). Marking is done by double clicking into the [Regional] field (toggles between yes/no).
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9.3 RadioText

Figure 11: RadioText configuration in RDS

RadioText can be transmitted as normal RadioText in group 2 or as enhanced RadioText (eRT) in the ODA extension
of the RDS standard with the possibility of using Unicode characters.

It is possible to transmit both versions simultaneously with different texts, but it is uncommon because of the limited
bandwidth of RDS. The different coding and/or texts can cause different position and length specifications of the
RT+ tags; therefore it has to be set if the RT+ applies for RadioText or Enhanced RadioText. This is signalled with
a bit in ODA group 3 of the RT+.

The groups for eRT and RT+ transmission have to be selected differently. They are transmitted as ODA with their
AID identification in 3A groups (⇒ 9.1.7).

9.3.1 Standard RadioText (Group 2)

Normal RadioText is transmitted in group 2. Up to 64 characters can be transmitted in 2A groups, up to 32 characters
in 2B groups. The coding refers to table E.1 of the RDS standard. If another (non standard) encoding is used, a
character can use up more than one byte.

[#xx] inserts a single byte/character from the hex value [xx]. F.i. [#21] becomes [!] and [#0A] a line break.
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If Text A/B is activated, the Text-A/B-bit will be toggled each time the RadioText changes. This can happen when
changing from Text A to Text B or by changed tag information from a new playing song.

9.3.2 Enhanced RadioText (Unicode)

For eRT serveral unicode encodings are available. In the standard encodings (UTF-8 and UCS-2/UTF-16) the
encoded bytes for the single character ’A’ looks as follows:

• UTF-8: 0x41

• UCS-2LE: 0x41, 0x00 (little endian)

• UCS-2BE: 0x00, 0x41 (big endian)

The description in the RDS standard doesn’t state explicitly which of both UCS-2 codings (table E.2) has to be used.
Therefore, the software features both endiannesses.

Analog to Long PS (⇒ 9.1.3) any unicode character can be inserted directly with [#xxxx].

By checking [RT+ is valid for eRT] the RT/eRT bit in group 3A will be set. If set, the tags from RT+ are valid
for the enhanced RadioText. If not set, they are valid for the standard RadioText in group 2.

9.3.3 RadioText Plus (RT+)

Using RT+, certain areas in the RadioText can be marked as special data fields (position, length). A possible
application is e.g. signalling the position of the componist’s name or the song title in the text.

With each line, a tag is defined and numbered consecutively with $n. The RadioText [You hear $0 from $1] includes
the references $0 and $1. In the first line ($0), the tag [Item.Title], in the second line ($1) the tag [Item.Artist] is
chosen. If a song with ID3 tags is played by a channel, the RT+ tags from that ID3 tag is transferred automatically.
Otherwise, the dummy text deposited in the table is used.

9.4 Replaying RDS log files

Instead of generating a new RDS signal, it is possible to play a recorded RDS log from a file. The requested files
have to be added in the [Log files] tab. All lines from all files are sent continually round robin. After the last line of
the last file, the playout starts with the first line of the first file again. Paragraph ⇒ 9.5.2 describes how to save an
RDS log file.

To create faulty checkwords, there is a special format:
ABCD D314 1592 6535 8979

If there is a 0 in the place of A,B,C or D, the correct CW for the relevant block is computed but inverted.

With [Raw] format, the CW values can be set directly (13 bytes with 4x 10-bits CW).
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9.5 Packet Statistics

9.5.1 General

Figure 12: Packet statistics

The packet statistics display the sent RDS packets, itemized in groups for one channel at a time using the currently
chosen RDS source. The log can be filtered by selecting the desired groups. Additional information can be added to
each line in the log, f.i. the time stamp.

In the lower area a decoder runs along, which extracts a number of data (PS, AF, RadioText etc.) from the log. So
here a receiver is simulated. If a real receiver does not display the desired data, this internal log should always be
looked at first to make sure that the data is sent at all.

9.5.2 Save RDS-Log File

Additional information, e.g. timestamp, group or number of CW errors, can be displayed and logged, too. The log
can be saved as text file. Afterwards, this file can be repeatedly played out again (⇒ 9.4).

With [Raw] format, the checkword values are also stored (13 bytes = 8 databytes + 4x 10-bits CW).
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10 TMC Sources

Figure 13: TMC generator

The window is built analogously to the RDS sources: On the left new sources can be added or deleted, on the right
the traffic messages for the currently chosen source are edited.

Traffic messages can be added, deleted and edited. By adding labels, a message is enriched with additional informa-
tion. This turns a single-group traffic message into a multi-group message.

Instead of entering the event or location code directly, the [Event] and [Location] buttons open search dialogs for
this purpose. From these dialogs the found code can be dragged and dropped into the message.
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10.1 Preconditions

Setting Reason
activate group 8A Traffic messages (Alert-C) will be sent in RDS group 8A
activate group 4A some receivers need a local time stamp to work
activate group 3A ensure TMC detection in the receiver (System Information ODA)
choose source link a TMC source to all desired RDS sources in the basis settings (⇒ 9)
set CC with the country code (first letter in PI) the correct LTN for that country is assigned;

if not, receivers may discard the messages for unknown countries. Germany uses D or 1
set ECC the extended CC can also be sent in group 1A. Germany uses E0 as ECC
TMCpro TMCpro receivers have decryption keys for some sets of CC/SID/LTN.

A known set for germany is CC=D, SID=50, LTN=1, ENCID=31

TMC announcements are coded according to the Alert-C Standard (ISO 14819-1..6). For a detailed explanation of
the following parameters, please refer to this standard.

10.2 System Information (SI)

The TMC system information consists of Location Table Number [LTN], Service Identifier [SID], [GAP] Parameter,
time wheel [Mode] with Active, Window, Delay, Alternate Frequency Indicator [AFI] and Message Geographical Scope
(MGS) Bits International, National, Regional, Urban (INRU).

(!) In the 2018 standard, the time wheel [Mode] has been removed. Instead the Location Table Country Code
(LTCC), analogous to the first character of the PI code (⇒ 9.1.4) should be transmitted (Mode should remain
deselected). However, the time wheel mode can still be activated/set in the software for test purposes.

The selected variants of the SI are sent cyclically one after the other in 3A groups. The TMC Application ID (AID,
normally 0xCD46) is transmitted in all variants. Via the 3A groups, the TMC service is announced to the receiver via
the ODA mechanism (⇒ 9.1.7). The number of 3A groups per minute is defined in the RDS basic settings (⇒ 9.1).

The [immediate repeat] field specifies how often each traffic message is repeated in direct succession to improve
reception stability. All traffic messages are transmitted round robin in 8A groups. After the last message it starts
over with the first.

[GAP] limits the transmission rate, so that a certain number of other groups must always be transmitted between
two TMC groups. For example, with f.i. GAP=3 (gap of three other groups), only every 4th group may be a TMC
8A group. Thus max. 171 8A groups per minute can be sent (per stream). Whether the GAP is active is defined in
the basic settings of the group 8A (⇒ 9.1.6).

10.3 Tuning Information (TI)

The TMC Service Provider Name (SPN) can be transmitted in the TI in group 8A variants 4 and 5. The encoding
of the eight bytes is analogous to the PS (⇒ 9.1.2), i.e. a #21 generates the ! character.

10.4 Traffic Messages

Each added line in the [TMC messages] table generates one message (⇒Fig. 13). It consists of at least one event
and one location. Additional information labels can be added with [+ Label]. To open a search dialog for a location
or event, click the right mouse button in the message table or use the buttons [Event] and [Location].
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Figure 14: TMC location search

Figure 15: TMC event search

A search for the event [stationary traffic] (or [Stau]) should produce f.i. 123 matches. A code can be moved from
the search dialog to the event or location field using drag&drop.

The sending state of each message can be switched between [send, cancel, skip] by double clicking the field.
By cancelling, the corresponding cancel event from the same update class of the event is sent instead of the event
code. The receiver should delete the message then. The event 2047 (Null-Message) with the special Location Code
65535 can by used to delete all messages of the current service.

10.5 Additional Content

By adding some labels (additional message content), a single-group traffic message becomes a multi-group message.
Up to five RDS 8A groups are allowed per message. That means 5*28 = 140 bits are available for additional content.
The diversion bit and the duration are directly sent within single-groups. In multi-groups they have to be added as
optional content with Label 1 (Control Code) with value 5 (diversion bit set) and Label 0 (duration).
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Label (4-bits) Description (0..16-bits)
0 Duration depends on (last) event, value 0 not allowed
1 Control code value between 0..7, f.i. 5 for diversion bit set
2 Length of route affected 0..31, f.i. 5 for 5 km
3 Speed limit advice 0..31, f.i. value 10 means 50 km/h
4 Quantifier 5-bits 0..31, depends on (last) event
5 Quantifier 8-bits 0..255, event specifies which Q is used
6 Supplementary code 0..255, see supplementary info code table in ISO 14819-2
7 Explicit start time 0..255, f.i. 40 for 10:00 am
8 Explicit stop time 0..255
9 Additional event 11-bit event code
A Diversion instruction 16-bit location code from same LTN
B Destination 16-bit location code
C Reserved/Precise Location 16-bit
D Cross link problem source 16-bit location code
E Separator 0-bit (no value), separate Label 2 and 3, group Label A
F Reserved

11 Remote Control

Remote controlling the MultiFM software is possible by connecting to TCP port 1248. With a simple Telnet program
(e.g. Putty in Telnet mode) commands can be send and events monitored. A simple client software with a command
history and event management is available on our website.

Command Description
HELP key Show information about a key, e.g. help rds.1.pty.
REG key Register events for a key, i.e. adjustments are monitored.
UNR key Do not monitor events for a key any more.
GET key Output the value of a key.
SET key value Set the value of a key on the new value value.
ADD key value Add a list entry
DEL key Delete list entry or complete list
NEW file Create a new, empty project with the name file.
DIR [path] [mask] List files in directory path, e.g.: dir . *.fm.
LOAD file Load project with the name file.
SAVE file Save project under the name file.
VER Show the versions of software (generator) and hardware.

Command Description
get * lists all currently available groups (sources) with numbers
get channel.1 list all values of channel 1
get channel.1.freq show frequency of channel 1
get channel.2,4-6.freq list frequencies of channels 2 as well as 4, 5 and 6
set channel.11-15.used 1 turn the channels 11 to 15 on
get playlist.2 list entries (songs) of second playlist
get rds.3.lps show Long PS of third RDS-Source
add rds.1.afs 958 add 95.8 MHz to manual AF list
help channel.1.volm show a short description about this key:

channel.1.volm channel audio pcm volume (linear) [0-100] %

set modul.off stop Modulator (dont send any RF)
set board.band 2 set RF band 2 (Brasil 76-108 MHz)
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A key always has the format g.#.w with g=group, #=number or range n-m (0<n<m<25) and w=value.

If an unknown command is entered, a list of all commands will be shown:
commands: REG UNR GET SET ADD DEL NEW LOAD SAVE CD DIR LIST HELP VER

If a parameter of a command is missing a short description will be shown, f.i. for SET
set key data example: SET channel.1.freq 95.8

For a list of all available parameters and their description see ⇒ 13.

The paths for the commands DIR, NEW, LOAD, SAVE, CD can be absolut (C:/Users/...) or relativ (./fmfiles/...)
to the current directory.

(!) All character strings have to be sent as UTF-8.

11.1 List Management

The commands ADD, SET and DEL are used to manage lists.

List (Key) Description
playlist.N.# song list for playlist N
rds.N.af sent AF list of RDS-Source N (read only)
rds.N.afs manual AF (Alternative Frequencies) list entries
rds.N.afr regional AF entries (within manual AFs)
rds.N.eon.# EON value list
rds.N.eon.af AF list of an EON entry
rds.N.rttag.# RadioText+ tag list
rds.N.files list of RDS log files to play out (instead of using the generator)
tmc.N.# TMC message list of TMC-Source N

Example Description
get rds.1.eon list all EON entries
add rds.1.eon 0 d311 1 2 3 4 add one EON entry
set rds.1.eon.2 0 d311 5 6 7 8 change EON entry 2 (if existing)
del rds.1.eon.2 remove EON entry 2 (if existing)
set rds.1.eon.0.af 958 1030 set AF to 95.8 and 103.0 MHz for EON entry 0
add rds.1.eon.0.af 1026 add 102.6 to AF list of EON entry 0
del rds.1.eon.* remove complete EON list
del rds.1.afs remove all manual set AFs
set rds.1.afs 958 1026 set two manual AFs (95.8 and 102.6 MHz)
set rds.1.afr 958 mark AF 95.8 MHz as regional
add tmc.1 1 2 3 4 add one TMC message in TMC-Source 1
del tmc.1.* remove all TMC messages in TMC-Source 1

11.2 Channel Info, RDS-Log

With the channel information (chinfo) status changes of all channels (1 to 24/48/72/96) are displayed. These
values can only be read, but not set.
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Channel Info Description
chinfo.#.playpos current playback position [0..1000]
chinfo.#.playing current song (filename)
chinfo.#.playrate current samplerate
chinfo.#.dist minimum distance in MHz to next transmitting channel
chinfo.#.rdslog.#n transmitted RDS-Log with #n = RDS source number
chinfo.#.rdscount.#n number of transmitted RDS blocks (13 Bytes)

Examples Description
REG chinfo.1.playpos monitor playlist position of a song from 0 (start) to 1000 (end)
REG chinfo.*.playing monitor song changes of all channels
REG chinfo.1.rdslog monitor RDS-Log of channel 1
SET rdslog time raw data group configure RDS-Log:

time is the time stamp
raw are the 13-Bytes of an RDS block with CheckWords
data are the 8-Bytes RDS data without CWs and
group is the data-extracted RDS group.

11.3 Modulator State

All commands (apart from HELP, GET, DIR and VER) produce an [command ok:] in case of success or an [command
error:] reply. If neither okay nor error is received, the command or reply UDP packet may got lost. The command
should be repeated.

Starting from an empty (NEW) or a pre-defined (LOAD) project, the state of the modulator is always known to the
remote control.

Please note: When making alterations in the MultiFM Generator’s GUI simultaneously to remote controlling, the
related events should be registered by the remote control REG command for their recognition (to track any changes
of the current modulator state).

11.4 Feed RDS Data

The MultiFM Software listens on TCP ports 4001 to 4096 for line by line RDS data to be sent out on channels 1 to
96. All formats that can be created in the packet statistics as RDS-Log (⇒ 9.5.2) can be used here.

The reply consists of a counter and the current buffer fill state of the RDS queue. The counter gives the number
of packets received for the current connection. A fill state 0 means that there are no more packets to send. The
internal buffer of the modulator hardware can hold 19 packets (that means less than two seconds sending time). A
higher fill state means that there are more packets waiting in the software to be sent to the hardware.

An error will be signalled with fill state -1, the RDS packet with number counter was discarded.

Operation Text
Send D314 1234 5678 9ABC

d361d283634e4d361398c4830b 0B
Error Test

Reply 425 51 (counter = 425, fill state = 51)
426 52
427 -1 51 noRDS

The example Client software can open an RDS-Log file and send it to any port for demonstration purpose.
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12 Application Examples

The following examples provide a step by step explanation on how to create different FM projects.
All examples are integrated in the software but can also be downloaded from:

https://www.maintech.de/multifm

12.1 Send two Sinusoidal Tones on 100 MHz

In this example, two sinusoidal tones (110 and 220 Hz) are sent on channel.1 on 100 MHz.

Via remote control, perform following commands consecutively:

Command Description
new 11-1 remote.fm Start new empty project
set audio.1.used 1 Add and activate audio source
set channel.1.idaudio 1 Choose audio source
set channel.1.freq 100 Set channel to 100 MHz
set channel.1.used 1 Activate channel, sinus should be audible
set audio.1.frq1 220 Change frequency for the left channel
set audio.1.frq2 110 Change frequency for the right channel
set audio.1.name Sinus-1 Change name of the audio source
set channel.1.mono 1 Set channel to mono (channels are mixed)
get channel.1 Display values (optionally)
get audio.1 Display values (optionally)

In the MultiFM software, the same result can be achieved by doing the following:

1. Choose menu Project ⇒ New (or Ctrl+N) and choose a new project name.

2. Goto the [Audio] page and add a new source with the button [+ Source].

3. Set the frequencies to L: 220 Hz (left) and R: 110 Hz (right).

4. Edit the source name from [Audio-1] to [Sinus-1].

5. Goto the [Channels] page.

6. Activate Channel 1 by clicking on the [1] button or press key 1.

7. Click the frequency and set 100.00 MHz with the slider (or type 100).

8. Set the audio source for Channel 1 from [<none>] to [Sinus-1].

9. Click the displayed stereo symbol to switch to mono.

The status display for channel 1 should be similar to ⇒ 16; using a receiver, both tones should be audible.

Figure 16: Channel 1 with sinusoidal tones

Open the created project with a text viewer. It should contain the following content:
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[channel.1]

freq=100.000

gain=0

volm=60

idaudio=1

used=1

mono=1

[audio.1]

used=1

frq1=220

frq2=110

name=Sinus-1

12.2 Three Songs on Three Channels

In this example, different music tracks are played out on three different channels.

In the MultiFM Software do the following steps:

1. Choose menu project ⇒ New (or Ctrl+N) and choose a new project name.

2. Choose the [Audio Sources] tab and add three sources with the button [+ Source].

3. Set all sources to [File].

4. Add at least three songs with [+ Files].

5. Drag&Drop each of the files into one of the audio sources.

6. Choose the [Channels] tab.

7. Activate channel 1, 2 and 3 with the mouse or by pressing the keys 1, 2 and 3.

8. Set the audio source of channel 1, 2 and 3 to [Audio-1], [Audio-2] and [Audio-3].

Tuning the receiver to each of these frequencies (⇒Fig. 17), all should play their selected song. The songs are
repeated continually.

Figure 17: Play out three song on three channels
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12.3 Automatic channel change via AF

Alternatice Frequencies are transmitted in the RDS signal of a channel. In this example, the automatic change to a
stronger channel is simulated. For this, the example from ⇒ 12.2 is extended. A RDS source that transmits the AFs
of the other channels is added to the three channels. When the tuned signal is attenuated, an AF-enabled receiver
should switch to another, stronger channel.

Open the example from paragraph ⇒ 12.2 and do the following steps:

1. Choose the [RDS Sources] tab and add a source with [+ Source].

2. Change to tab [Alternative Frequencies].

3. Activate [send AF in Group 0A] and [Automatic channel operation] (see ⇒ 9.2.1).

4. Activate [Group 0] in the [Basic Settings] tab.

5. Choose the [Channels] tab.

6. Set the RDS sources for all three channels 1-3 to [RDS-1].

7. Check the currently set receiver frequency (or the music track).

8. Attenuate the signal of this frequency gradually with the attenuation slider.
(click on the channels [-n dB] field to open the slider, use mouse wheel, cursor keys or drag the circle)

At a certain signal level, the receiver should switch to one of the stronger channels. Observe this station change in
the played music or in the frequency displayed by the receiver. Attenuate and amplify the signal level of all three
channels and observe the receiver behavior.

• At which attenuation (-n dB) does the receiver tunes to a stronger station?

• Is there a hysteresis (in dB)?

12.4 Enhanced RadioText with RadioText+

In this example, a RadioText is configured and sent with additional RT+ tags.

1. Create a new project with one channel and one RDS source.

2. In the [RDS] and [RadioText] tab activate [send] for RadioText ⇒Fig. 11.

3. Enter [You’re hearing $0 by $1.] in the first line.

4. Activate [send RadioText+ tags].

5. Add two lines with the tags [Item.Title] and [Item.Artist].

6. Enter [a track] as dummy title.

7. Enter [an artist] as dummy artist.

Now the following RadioText should be displayed by the receiver:
You’re hearing a track by an artist.

When play out a tracks with an ID3 tag, the RadioText will change to e.g.:
You’re hearing Pass This On by The Knife.

Repeat the same with enhanced RadioText:

1. Deactivate [send] for RadioText and activate [send] for enhanced RadioText.

2. Enter [Playing $0 from $1.] in the first line.

3. Activate [Group 3A for enhanced RT] to send the ODA announcement for eRT.

If no RadioText is displayed anymore, please change the Unicode encoding until the receiver can decode and display
the text (⇒ 9.3.2).
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12.5 RadioText from Hex values

In this example, RadioText is created directly from freely chosen hex values. A new project is created and saved first.
Afterwards, the RadioText is altered.

The following commands are performed consecutively:

Command Description
new 11-5 radiotext.fm Create a new empty project
set channel.1.idrds 1 Choose RDS source
set channel.1.freq 100 Set channel 1 to 100 MHz
set channel.1.used 1 Activate channel 1
set rds.1.used 1 Activate RDS source 1
set rds.1.rtxt 1 Activate Standard RadioText
set rds.1.rta #41#42#43 Set RadioText ABC from hex values
set rds.1.2 4 Set sending rate of RadioText group 2 and start transmission
save 11-5 radiotext.fm Save project
get channel.1 Display values (optionally)
get rds.1 Display values (optionally)

Afterwards the RadioText is changed to [HELLO WORLD] with the command:
set rds.1.rta #48#45#4C#4C#4F#20#57#4F#52#4C#44 creates ⇒ HELLO WORLD.

12.6 Announce two Traffic Jams

In this example, two traffic jam announcements are configured and sent.

• Create a new project with one channel, one RDS and one TMC source.

• Acticate [Group 8A: TMC] in the [RDS] ⇒ [Basic Settings] tab (Fig.⇒ 9).

• There choose [TMC-1] as TMC source.

• Activate [Variant 0] and [Variant 1] for this TMC-1 source in the [TMC] tab (Fig.⇒ 13).

• Set the [PI-Code] to [D314] (see CC notice in paragraph ⇒ 10.1).

• Add two traffic announcements with [+ Messages].

• Open menu [Search Event] (right mouse key in the traffic announcements).

• Search for [Stau].

• Drag or enter the codes [101] and [352] into the event fields.

• Open menu [Search Location].

• Search for [Kist].

• Drag or enter the codes [10849] and [10851] into the location fields.

• Activate a channel and choose [RDS-1] as RDS source.

Configure the receiver to display traffic announcements. Some receivers may require to connect a GPS antenna to
know the country location to be used for traffic.
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13 Remote Controlable Parameters

The following parameters can also be changed by remote control instead of the software GUI. To set and get a
parameter the # number of the channel or source must be given (see examples in ⇒ 11).
The parameters are divided into the following groups:

Groups Name Description
channel.# Channel parameters # channel number (1..24/48/72/96)
chinfo.# Channel information # channel number (1..24/48/72/96) (read only)
audio.# Audio-Sources # number of the Audio-Source
playlist.# Playlists # number of the Playlist
tmc.# TMC-Sources # number of the TMC-Source
rds.# RDS-Sources # number of the RDS-Source

Parameter Range Description
channel.used 0/1 toggle channel on/off
channel.freq 87,5..108 MHz transmission frequency (Japan 76..90, Brasil 76..108)
channel.gain -60..0 dB gain from 0 (full power) to -60 (noise-floor)
channel.volm 0..100 % audio pcm volume (linear)
channel.mute 0/1 mute audio
channel.mono 0/1 channel is 1=mono or 0=stereo
channel.devi 0..130 kHz deviation
channel.emph 0/1/2 preemphasis 0=none, 1=50, 2=75 µs
channel.rate Hz sample rate (32000, 44100 or 48000 Hz)
channel.auto 0/1 auto sample rate change on song change
channel.aof -1000..1000 dB attenuation offset
channel.att string attenuation unit
channel.rds string rds file to replay
channel.idrds link rds.# used rds source id
channel.idaudio link audio.# used audio source id

chinfo.playpos 0..1000 current playback position
chinfo.playing string current song (filename)
chinfo.playrate Hz current samplerate
chinfo.dist MHz minimum distance in MHz to next transmitting channel
chinfo.rdslog.# string transmitted RDS-Log of RDS-Source number #
chinfo.rdscount.# int number of transmitted RDS blocks (one block = 13 bytes)

Parameter Range Description
audio.used 0/1 audio source enabled/disabled
audio.name string audio source name
audio.type 0/1/2 audio type 0=sinus, 1=ramp, 2=file or playlist
audio.frq1 10..22000 Hz first frequency for sinus/ramp
audio.frq2 10..22000 Hz second frequency for sinus/ramp
audio.vol1 0..100 % first volume for sinus/ramp
audio.vol2 0..100 % second volume for sinus/ramp
audio.time 0..60 s ramp duration
audio.file string file/playlist name

playlist.name string playlist name
playlist.# string list playlist file names

– 28 –



Parameter Range Description

rds.used 0/1 rds source enabled/disabled
rds.name string rds source name
rds.ps string program service name
rds.pi 0..0xffff program identifier
rds.tp 0/1 traffic program bit
rds.ta 0/1 traffic announce bit
rds.ms 0/1 music speech bit
rds.pty 0..31 program type
rds.dec 0..3 decoder bits 3:dynPTY 2:compressed 1:artific 0:stereo
rds.rttag.# list 2 radio text tag (2 values)
rds.rta string radio text A (group 2)
rds.rtb string radio text B (group 2)
rds.rtc string enhanced radio text C
rds.rtd string enhanced radio text D
rds.pn1 string program type name 1
rds.pn2 string program type name 2
rds.tmcsi link tmc.# used tmc source id
rds.rtgrp 0..255 radio text plus ODA group
rds.rtbit 0..65535 radio text plus message bits
rds.rtitm 0..255 radio text plus items bits
rds.rtxt 0..255 radio text mode &1=use radio text, &2=use enhanced radio text

(≫2)&3=unicode mode, &16 toggle AB-Bit, &32 group 2B, &192 group 3
rds.ertg 0..255 enhanced radio text group
rds.ertb 0..65535 enhanced radio text message bits
rds.pss 0..255 ps scroll mode &8=scroll ≫4+1=repeat &7=rate
rds.afu 0..15 af bits, 1=use, 2=auto, 4=manual, 8=A/B
rds.af int list automatic af list (* 0.1 = MHz/kHz) read only
rds.afs int list 876..16100 manual af list (* 0.1 = MHz/kHz)
rds.afr int list 876..16100 rds regional af list (for method B)
rds.rpa 0..255 radio text A repeat
rds.rpb 0..255 radio text B repeat
rds.rpc 0..255 radio text C repeat
rds.rpd 0..255 radio text D repeat
rds.rp1 0..255 program type 1 repeat
rds.rp2 0..255 program type 2 repeat
rds.zone -12..12 h group 4 UTC zone hour offset, &32 mins, &64 days
rds.mins -960..960 min group 4 minute offset
rds.days days group 4 fix date (days since 1.3.1900)
rds.date 0/1 group 4 use 0=date of today, 1=fix date from days
rds.err 0..255 error generator 0=invert, 1=set to 0, 2=set to 1, &128=on
rds.ber 0..100 % bit error rate for error generator
rds.fix 0..255 fix bits 1=checkword, 2=group, 4=pi, &128=exact ber bits per group
rds.page 0..255 group 1 radio paging (5 bits)
rds.slow 0..65535 group 1 slow labeling code
rds.pin 0..65535 group 1 program item number
rds.fused 0/1 play log files on/off
rds.files play log file list

rds.gmin.# list ±685 g/min group #=0..15A|16..31B groups per minute for streams 1..4
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Parameter Range Description

rds.eon.# hex list 6 eon data of exact 6 hex values: Channel PI PTY TP TA Link
rds.eon.ps string eon program service name
rds.eon.af list 876..16100 eon alternate freq list ∗10 (876 = 87,6 MHz, 16100 = 1610 kHz)
rds.eoc1/2 0..100 eon ta on/off burst count
rds.eot1/2 0..100 eon ta on/off burst time in dsec
rds.buc1/2 0..100 group 15B ta on/off burst count
rds.but1/2 0..100 group 15B ta on/off burst time in dsec

rds.oda.# hex list RDS2 ODA data: A B C D cwA cwB cwC cwD G0min G1min G2min G3min on/off

tmc.used 0/1 tmc source enabled/disabled
tmc.name string tmc source name
tmc.flag int enable &1=group3 &2=tmcpro &4=skt
tmc.ltn 1..63 location table number LTN
tmc.sid 0..63 service identification SID
tmc.aid hex tmc AID application id (usually CD46)
tmc.gam 0..255 bits &192=GAP mode &32=AFI &16=Mode &15=MGS INRU
tmc.awd int timing active window delay for Mode=1
tmc.rpt 1..50 immediate group 8A repeat
tmc.rate 1..255 ENCID group 8A sending rate in seconds
tmc.enc 0..31 ENCID encryption id to use for TMCpro
tmc.skt hex list service key table for encryption
tmc.# int list duration extent event place send [multigroup labels...]

board.band int frequency band: 0=EU, 1=Japan, 2=Brasil [0..2]
board.attn int global RF attenuation [0..-31] dB

modul.info string get MultiFM Generator Software Version
modul string set/get RF modulation running (onair) or stopped (offline)
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